bcAnalyze - Manual
Version: August 2016, Version 3.0
Author: Dr. Volker Runkel

Contents
1.
2.
3.
4.

Introduction
Installation
Quick start
Basics

3
3
3
5

4.1. Sound definitions
Sound
Frequency
Microphone
Sample rate
Amplitude resolution
Sound Pressure Level, override (Clipping)
Frequency analysis

5
5
5
5
5
6
6
6

5. First steps

7

5.1. Open files
5.2. Zooming and selecting sound

7
7

6. Analyzing signals
6.1.
6.2.
6.3.
6.4.

7.

8

Spectrum
Sonogram
Call overlay
Waveform statistics

8
9
11
12

Finding and measuring calls automatically
7.1.
7.2.

The call finder and its requirements
Working with the automatic call finder

8. Play calls
8.1. Time-delay player
8.2. Virtual heterodyne detector

9. Sound manipulation
9.1. Changing samplerate
9.2. Amplify
9.3. Generate
9.3.1.Silence, white noise, sinus
9.3.2.Generate bat call
9.4. Filter

10. bcCalls documents
11. CSV documents

12
12
13

13
14
14

14
14
14
14
14
14
15

15
16
Handbuch bcAnalyze 3 Version 3.0 - Seite 1

12. Preferences

16

12.1. General
12.2. Display
12.3. Call finder
12.4. Sonogram

16
16
16
16

Handbuch bcAnalyze 3 Version 3.0 - Seite 2

1. Introduction
With bcAnalyze you have one of the most modern tools for analyzing bat echolocation and
social calls. While the application was fine-tuned for using bat corder recordings other files
in wave-format can be read and analyzed nearly as well. The application focuses on a fast
display and analysis of sound files embedded in an easy to use user interface. A special
algorithm for finding bat calls within recordings allows the automatic extraction of call parameters. The following pages cover bcAnalyze 3 Light as well as the Pro version. Pro
chapters and functions are marked as such.

2. Installation
bcAnalyze requires an Apple Mac running OS X 10.9 or newer. We recommend memory of
at least 4GB. Both versions, light and pro, are available through the Mac App Store and
installed from there automatically after purchase.

3. Quick start
If you have worked with other sound analysis tools before, you recognize bcAnalyze is
built in a similar way. After opening a sound file (batcorder raw of windows wave), you see
an waveform or oscillogram display of the sound. Above the wave form a sonogram for
quick call display is shown. If the sound file was already analyzed with the call finder (for
example in bcAdmin) and a bcCalls file was stored, the found calls are displayed as well
as overlay over the sonogram (can be disabled).
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After selecting a piece of sound you can calculate and show a spectrum display or a measurement sonogram. If found calls are available the tab key quickly browses through the
call list while ⌘+R creates a sonogram of the selected call. See more on the features of
bcAnalyze on the following pages.
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4. Basics
4.1. Sound definitions
Sound
Sound is an oscillation of air pressure which spreads as a wave with a velocity of ca. 340
m/s. An oscillation of one specific frequency is called a pure tone, which results in a sinus
wave when outlined over time. Such an illustration is called wave display or oscillogram.

Frequency
The frequency of sound is de ned by the number of oscillations per second [Hz - Hertz].
Depending on the frequency sound can be classified as infrasonic sound (below 16 Hz),
audible sound (16 Hz up to 20 kHz, audible for humans), and ultrasonic sound (20 kHz up
to 1 GHz). In contrast to a pure tone, sound (in terms of noise) is composed of many frequencies that change over time. A tone is a periodic signal generated by several pure tones.
Microphone
A pressure sensor (microphone) detects changes in air pressure and transforms these into
electrical pulses. These pulses ideally (exact linear transformation) form a wave as explained above. This is still an analogue signal (continuous signal), which has to be transcribed
in discrete time and amplitude steps in order to digitalize it.
Sample rate
The sample rate defines the time interval for reading out the signal. The sample rate has to
be significantly higher than the frequency of the respective signal. For an accurate digital
reproduction of an acoustic signal, the sample rate has to be twice as high as the maximal
frequency of the analogous signal (Nyquist-Shannon Sample Rate Theorem). An audio CD
for example is recorded with a sample rate of 44.1 kHz in order to reproduce human audible frequencies from 50 Hz up to 20 kHz. For bat calls the sample rate should be at least
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250 kHz because echolocation calls can reach up to 125 kHz. We recommend a sample
rate of 500 kHz for the automated analysis with bcAnalyze.
Amplitude resolution
This attribute denotes the possible amount of amplitude values for digitalization. For a resolution of N exactly 2N values have to be available, e.g. resulting in 65536 steps for 16
Bit. Generally, in acoustic digitalization each sample becomes digitalized with at least 16
Bit resolution, which corresponds to a theoretical dynamic of 96 dB. We recommend to
apply at least 16 Bit for a feasible analysis of ultrasonic signals.
Sound Pressure Level, override (Clipping)
The sound pressure level (loudness) can be specified linearly (pressure in Pascal or voltage in Volt). However, it is more common in acoustics to use a logarithmic scale: Decibel
dB, which describes the loudness with the common logarithm of the ratio of two levels.
Therefore it is a relative unit without dimension, representing an increase with positive and
an attenuation with negative values. dB specifications are often related to a standardized
reference value: dB SPL is referenced to the human auditory threshold at 1 kHz and indicates how much louder a signal is as compared to this value. The great range between
quiet and loud can be comfortably expressed by this unit. For instance, a difference of 80
dB between two signals relates to a voltage ratio of 1:10.000. As a convenient rule of
thumb: a doubling of the sound pressure level (respectively voltage) results in 6 dB, a tenfold increase in 20 dB difference.
An override results if the analogue signal is louder than the input of the digitalization device (AD-Converter). The sinus wave is clipped and the signal gets adulterated. This also
applies to analogue amplifiers as they cannot produce a linear amplification (distortion). In
frequency analysis this causes deceptive frequencies.
Frequency analysis
There are several methods for an analysis of sound
signals. A simple and feasible method is the zero
crossing analysis: it calculates the oscillations per
second (frequency) by counting how often the
zero point is crossed and establishes a periodogram. With many consecutive measures a frequency progression over time can be constructed (see
Figure to your right-hand side). The Fourier Transformation is the most common method to analyze
an acoustic signal which is composed of several frequencies. This elaborate technique separates a periodic signal to its single frequency components. bcAnalyze applies a slightly
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less complex method, the Fast Fourier Transformation (FFT) for the calculation of spectra
and sonograms. Compared to a spectrum, which illustrates the frequency classes of a signal, a sonogram also depicts the temporal pattern of these frequencies.

5. First steps
5.1. Open files
Using the Open command or the Recent Documents menu, both located in the File menu
you can open files from hard disk. Alternatively bcAnalyze supports drag and drop from the
Finder. If bcAnalyze is set as standard application for a file type, it opens upon double-clicking a sound file in a Finder window.
Currently support for bat corder .raw and wave .wav files exists. Note that compressed
wave formats are not supported. If a wave file contains two channels (stereo), only one is
displayed at a time. You can easily switch between left and right channel using the channel
chooser below the oscillogram display. Wave files with a sample rate below 196 kHz are
interpreted as time-delayed recordings automatically.
After opening the file the waveform shows a linear display of the recorded sound wave.
Signals that reach the upper or lower boundary of the display are distorted. Below the waveform display to the left a checkbox allows to Normalize sound display based on the visible samples. In addition to normalizing the sound one can also use the slider control to
change the y-axis magnification. The x-axis shows the time and is labeled in milliseconds.
If call were found or exist for a recording bars on the x-axis indicate their position. Above
the waveform a sonogram display is visible.
Pro: To save changes to a file you can use File - Save as… and choose to store in raw or
wave format.
5.2. Zooming and selecting sound
Per default the full sound is displayed as waveform and sonogram directly after loading the
sound file. To zoom into the sound to get a more detailed view you can either use the +/keys or the buttons adjacent to the small magnifying glass symbol to the windows lower
right. A click on the magnifying glass zooms out and shows the full sound again. If you
hold the shift key while clicking the magnifying glass the current selection is zoomed to.
When moving the cursor over the waveform the current time and voltage value is displayed. With the left moue key cold down a selection can be drawn in the waveform, indicated
by the red rectangle. A selection will be used to calculate spectrum, sonogram or do a manipulation of that range of sound samples. The duration of the current selection is shown
rounded to milliseconds. Using the command Set selection from within the Edit menu allows a sample exact selection of sound. The Edit menu features a deselect and a select all
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command as well. An alternative is to create the selection by drawing a rectangle within
the sonogram. This displays not only the duration of the selection but also lowest an highest frequency of the selected range.
The sonogram display as such can be adjusted quickly by moving the mouse over the arrow-up button and choosing either a slider for color changes or one of the the two options.
The one called Calls toggles display of call measurements. These are, if activated, plotted
above the sonogram as an overlay. The second toggles display of the sonogram as such.
The sonogram features two bands helping quickly identifying frequency ranges of recorded calls. These bands can be adjusted in the application preferences. By pressing the
shift key a help line is added at the current moue position. Another press of shift disables
the line again.

6. Analyzing signals
6.1. Spectrum
A power spectrum is calculated using a fast fourier transformation and shows the amplitude or power distribution of the frequencies contained within the analyzed signal. A spectrum doesn’t contain any temporal information. Usually it is calculated over a single analysis window defined by the sound selection. The spectrum, if used correctly, is rather accurate regarding frequency measurements.
The window function defines a weighting of samples within the analysed block. While a
rectangle window weights all samples with the same,
5
full value, the other window functions have a bell

culating spectra. Spectrum calculation is working for
sample windows of a size of 2N samples. bcAnalyze
uses zero-padding to fit the selected sound into such
a window. So first you have to select the sound range
that you want to calculate a spectrum from. Usually
that will be a single bat call. Choose Spectrum either
from the toolbar or from the Analyse menu and the
spectrum will be displayed in a new window. The
graph shows a logarithmic display of power and a li-

4
Amplitude

shaped distribution of weights. Thus, parts of the
samples located at the beginning and end of the window are less pronounced than the middle part. The
larger the window size the higher is the frequency resolution. bcAnalyze displays the resolution when cal-
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near display of frequencies. You can choose the currently used window function from the

popup menu. Moving the moue over the spectrum activates a cursor that displays frequency and amplitude/power. For a smoother display you can use a smoothing function
that averages based on your selection.

6.2. Sonogram
A sonogram is generated by calculating many spectra over very short sample ranges and
combine them into a quasi two-dimensional image showing frequency over time. The frequencies amplitude is color-coded adding a third dimension. In contrast to a spectrum display the optimal window function is not a rectangle but one that has either a good temporal
or frequency response, or both. These types reduce the sidelobes (picket fences). The
available window types in bcAnalyze have all pros and cons regarding the resolution, the
best window function is the 7th term harris window. The following images show three different window types for the same signal.
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Hanning

FlatTop

7th term Harris

Frequency and temporal resolution of a sonogram is influenced by various parameters.
Mainly the FFT window size and the overlap both have the highest impact. The FFT size is
the number of samples analyzed per single calculation. The higher its value, the finer the
frequency resolution, while temporal resolution decreases. The overlap indicates how
many samples each window start are spaced. High values produce high temporal resolutions. Whenever a sonogram is opened in an extra window in bcAnalyze the resolution is
displayed shortly. Apart from window size and type the sonogram display can be adapted
by using the color popup in the upper right as well as the sliders.
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Moving the mouse over the sonogram show the current frequency and time at the mouse
cursor. While holding down the left mouse key one can draw a selection. The selection
features duration as well as upper and lower frequency. This helps to quickly get start-,
end-frequency and duration of a bat call.
The button control in the lower right toggle two kind of measurement overlays if measurements are available for the visible call.
If you have changed sonogram settings you can store them as default by doing a right
click on the sonogram and choosing the appropriate item from the context menu. The
same menu offers various other possibilities like saving the sonogram to an image or an
html page. The latter requires you to choose a folder to which an index file and the image
is saved. If the folder already contains an export produced by bcAnalyze the new sonogram is attached to the existing page. That way you can easily build a single web page
featuring a multitude of sonograms.
Pro: The pro version offers the possibility to copy a selected
sonogram area and paste it into another sonogram for comparing calls. The image is also available in the general pasteboard for other applications. After pasting such a sonogram
piece you can move it by either using the mouse, holding the
shift key locks movement to one axis, or by the arrow keys.
The arrow keys can be used together with shift to increase
the movement steps. Using page up or down increases or decreases the opacity of the
pasted sound piece. The Delete backwards key deletes the pasted image again.

6.3. Call overlay
Another tool to help identifying bat species is an overlay of call measurements. For this all
found calls are drawn into a rough grid in a way that the call ends are aligned. In addition
you can overlay stored references as well as self generated references from your own call
recordings using the bcCalls files.
Pro: You can open bcCalls files as own documents and copy & paste call data into one
large reference bcCalls file for the call overlay. The pro version offers to open bcCalls files
as separate documents.
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6.4. Waveform statistics
Pro: Located in the Analysis menu is a simple tool for evaluating waveform statistics of the
currently selected sound. It lists DC offset as well as minimum and maximum amplitude of
the selection. The results are shownah s percentage and as dB value relative to the maximum possible amplitude. The average RMS (root mean square) value is given in addition.

7.

Finding and measuring calls automatically

bcAnalyze offers a unique algorithm for finding bat calls within recordings. Found calls are
automatically measured for species identification and values are accessible by the user as
well. The calls are modeled by getting the instantaneous frequency for every 0.1 ms. This
data is displayed as overlay over the calls in the sonogram displays.
7.1.

The call finder and its requirements
The call finder and measurement extractor is based on a complex form of zero-crossing
analysis combined with statistical tests. In a first step possible calls are evaluated using a
choosable amplitude threshold. In the next steps all found calls are evaluated using statistics. That way badly recorded calls or non-call sounds are mostly eliminated. For the valid
calls parameters like start- and end frequency as well as the call overlay data are extracted.
Some requirements should be met by the recordings for a robust call extraction:
• the sound file must contain ultrasonic signals > 14 kHz
• the call must be tonal with a single accented main harmonic
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• the call must have a duration of at least 1.5 ms
• overlapping signals (call and echo for example) can not be extracted properly
• the call amplitude must at least reach the threshold given in - xx dB relative to maximum amplitude
• the recording background noise must be low respectively the signal-to-noise ration
must be good
• loud background signals must not mask the bat calls
Some oft the call finder parameters can be adjusted. Within the application preferences
you find an area for the call finder. It allows adjustment of the call finder threshold. The lower the value (note -36 dB is lower than -30 dB), the more calls can potentially be found.
The quality setting is used for the statistical tests of the call finder. The higher the value the
lower the quality can be to get a found call. A value of 20 usually is optimal for all call situations. If you lower the value towards zero fewer calls will be found. If you work with bat
corder recordings you should adapt the call finder threshold to the bat corder threshold value for optimal performance. The selected threshold can be displayed in the waveform
view. Choose View from the main menu and Show threshold within there. It is displayed as
a horizontal line.
7.2.

Working with the automatic call finder

A recording can be searched for calls using the Call finder toolbar action or Find calls from
the Analysis menu. If recordings were analyzed using bcAdmin the calls are already stored
per recording in the .bcCalls file and are automatically read from there. For example this is
a pair of files to expected after bcAdmin analyzed the recording:
250508-ZWEIM2XXXX-0004.raw
250508-ZWEIM2XXXX-0004.bcCalls
The found calls are listed as a table in the call list popup. There you can read out values
like start- and end frequency as well as user defined modal frequency (FMod), Frequency
of last millisecond (Flastms) or Frequency at lowest slope (FRmin).
Pro: After calls were found these are not automatically saved to disk. Using the export option in the Calls menu (main menu) will save the found calls to a bcCalls file.

8. Play calls
Pro: Some users prefer to listen to recorded calls. The integrated sound player either replays a time-delayed version of the recording or a heterodyne version. You can start the
player either via the speaker symbol in the toolbars info field or using ctrl+space.
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8.1. Time-delay player
Pro: This mode reduces the samplerate by a factor of 10 without altering the sound. Thus,
the originally ultrasonic signals are played at a tenth of their recorded frequency and thus
audible to us.
8.2. Virtual heterodyne detector
Pro: The heterodyne mode simulates a handheld heterodyne bat detector. You can choose
the frequency and listen to your recording just like ein the field.

9. Sound manipulation
Pro: Various tools for sound manipulations exist in bcAnalyze Pro. These allow to filter
sound, change the samplerate or generate sounds.
9.1. Changing samplerate
Pro: The Edit menu holds an item for changing the samplerate. This can be done with or
without changing the samples. In the first case the sound is resampled to the new sampling rate. If you lower the rate, frequency above half the new rate will be gone in the new
sound. If you deactivate resampling the frequencies will shift according to the difference of
old and new samplerate.
9.2. Amplify
Pro: The command Edit-Amplify increases or decreases the signal amplitude according to
the given value.
9.3. Generate
Pro: You can generate silence, white noise, sinus signals and bat calls by choosing the
appropriate option from the Edit - Generate menu.
9.3.1.Silence, white noise, sinus
Pro: These functions allow generation of the selected signal-type for either the selection
duration or a given duration. The signal is inserted at the waveforms insertion point.
9.3.2.Generate bat call
Pro: You can create a bat call like signal that can be used with a bat lure for example. The
tool allows you to „draw“ a call that can be then generated as sound including amplitude
variations. You either have to create a new 500 kHz sound file or open one with 500 kHz
samplerate. Choose from the Edit- generate menu the Bat call generator and a window
opens up for drawing the bat call.
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Designed calls can be saved to disk and reopened later again. Use the button Clipboard or
Insert to generate the designed call.
9.4. Filter
Pro: Simple biquad-filters allow bandpass-, low- and highpass filtering of selected sounds.

10. bcCalls documents
Pro: If calls are measured with bcAdmin the results are stored in .bcCalls files. Creating
these from bcAnalyze is possible as well. These files can be opened just like a recording.
The stored calls are listed in a table. Call overlays and optionally the measurements can
be displayed for all calls. Calls can be copied between bcCalls documents. That way you
can for example generate a file to be used with the call overlay feature of bcAnalyze.
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11. CSV documents
Pro: When measuring and extracting calls csv files can be generated for use with batIdent
and automated identification. These can be opened and displayed in bcAnalyze. A simple
graph showing a scatterplot of measurements can be opened as well.

12. Preferences
The behavior of bcAnalyze can be adjusted via application wide preferences. These preferences are separated into various topics.
12.1. General
The general settings pane holds common settings for bcAnalyze. You can choose a standard channel for display when opening stereo recordings. The delay factor of time-delayed
recordings is set here as well. If calls are available for a recording the call list display can
be adjusted here as well.
Pro: Choose if the first call is automatically selected and zoomed to upon opening a file or
if the call list should be displayed automatically if calls are available. If you create a new
document you can choose how it should be pre-filled. When exporting measurements to
the clipboard a decimal format can be specified.
12.2. Display
For the main window of each document the waveform display and the overview sonogram
can be adapted.
Pro: The pro version allows to make inactive documents semi-transparent and larger fonts
to be used for displaying measurements and values.
12.3. Call finder
Call finder settings are adjusted here.
12.4. Sonogram
Settings for the measurement sonogram (displayed in the extra window) can be adjusted.
This includes window size, type and overlap as well as the color scheme.
Pro: In addition to the application supplied color schemes you can choose a .tif file with
your own color blend. The file must be 1 pixel high and 256 pixels wide.
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